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462198

When you upgrade the domain from Informatica 9.0.1 to 10.1 and the domain configuration
repository uses an Oracle, Sybase ASE, or Microsoft SQL Server database, the upgrade fails with
an error. The upgrade error might vary depending on the database.

The upgrade fails with the following error for an Oracle database:

java.sql.SQLException: [informatica][Oracle
JDBC Driver][Oracle]ORA-00932: inconsistent datatypes: expected -
got CLOB

The upgrade fails with the following error for an Microsoft SQL Server database:

QutPut : [ICMD_10033] Command [upgradeDomainMetadata] failed with error [[PERSISTENCEAPI_0307]
[PERSISTENCECOMHON_0070] Internal error. Error occurred while executing the query with name
getAdministratorGroup', and SQL query implementation 'SELECT a0.PSRESOURCE_CONTAINER.id from
com.informatica.isp.metadata.usermanagement.impl.GroupImpl a0 where
a0.surrogateERDbObjectId.proxyResourceId=0 and a0.surrogateERDbObjectId.namespaceId=5 and

(,( (a0.securityDomain) LIKE ('Native') ) AND (LOWER (a0.name) LIKE LOWER
('Administrator’) ) )." This was caused by [informatica][SQLServer JDBC Driver]
[SQLServer]Argument data type ntext is invalid for argument 1 of lower function.].

458391

Attempts to fetch data from an SQL Data Service fail when the physical data source contains
Unicode characters.

457601

When the domain creates system services before it assigns them to a node, you cannot use the
Administrator tool to edit the service properties, and functionality of the system services is
limited.

454733

The infacmd cms purge command might delete an active reference table if you run the
command after you run the infacmd rtm deploylmport command more than once.

453906

When a connection name contains the characters "ID" a mapping fails to compile because the
connection is not found.

453555

When a web service request times out waiting for a web service or when you stop the web
service from the Monitoring tool, the Data Integration Service shuts down.

452075

A workflow fails to run if it contains a gateway that connects directly to another gateway with a
conditional sequence flow that you configure as the default sequence flow.

450874

When mapping logic contains the IN() function and the mapping logic is pushed down to the
source, an outer join returns incorrect results.

450809

Ajava-level deadlock occurs when the alert service, the user management service, and domain
configuration service wait on each other. For example, a deadlock occurs in the following
situation: The alert service checks for user permissions while processing an email alert for a
node inactive event. At the same time, the user logs in to the Administrator tool and the
inactive node registers with the domain.

4506014

The Model repository does not respond when web services are invoked for the first time.

450551

A security vulnerability enables any user to browse to any known file in the Model repository.
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Description

449011 When the master node in a grid fails over to a non-master node, the Content Management
Service on the non-master node cannot find the reference data audit tables.

446677 Unable to associate users to a group if the group has more members than the value of the
MaxValRange limit set for the LDAP server.

445152 When you upgrade from 9.6.1 to 10.0, the Model repository service fails with the following error:
The Repository Service operation failed

444741 If a Mapping task fails in a workflow and runs to completion when the workflow recovers, the
workflow graph does not reflect the completed status of the task.

443212 The Model repository requires a minimum values for the maximum heap size setting. Set
maximum heap size to the recommended value of 1 GB, and the maxPermGen size to 512 MB.
Lower settings generate an error.

443186 When you select a parent group in the Create Group wizard, the new group appears in the
Native folder but is not nested under the parent group.

442538 If you update the connection details on exception record database, you must recycle the Data
Integration Service before you run a workflow that writes data to the database.

442371 When you remove a node with the compute role from a Data Integration Service grid or disable
the compute role on a node in the grid, the node is no longer listed in the Compute view for the
service. However, the service retains the previously configured compute values for the node. If
you add the node back to the grid or enable the compute role again, the node is configured
with the previous values instead of the default values.

442043 When you run the infacmd sch updateschedule command, the schedule end date changes to
No End Date. The end date changes regardless of whether you specify a value for the -ed
option.

441895 When you schedule a job to run every 23 hours, the Scheduler Service might run the job at the
wrong time.

441315 When you define a schedule with a repeat count value, the schedule properties do not display
the value that you specify.

441302 You can configure a schedule that specifies a start date that is in the past.

440876 Workflow recovery fails when the workflow database is a Microsoft SQL Server database that
uses a non-default schema.

440099 If the Data Integration Service stops unexpectedly while a Mapping task runs on grid, the
monitoring tool indicates that the mapping is aborted and that the Mapping task is running.

440033 The monitoring tool indicates that a Mapping task in a workflow is running when the task failed
because Data Integration Service execution instance was unavailable.

439709 In a mapping with a flat file data source that includes a column with double data type, the Data

Integration Service erroneously reads data that should be rejected because it contains non-
numeric characters. For example, the row should be rejected when it contains a value such as
12345678901234567890123456ab, but the Data Integration Service fails to reject the row. Instead, it
reads the numeric characters and ignores the non-numeric characters.

Informatica Domain Fixed Limitations
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Description

439560

A Consolidation transformation writes different values to the IsSurvivor port in the native
environment and in the Hadoop environment.

438472

You can run infacmd wfs recoverWorkflow to restart a workflow that is not enabled for recovery.

436938

If a Command task in a workflow enters a canceled state and runs to completion when the
workflow recovers, the monitoring tool does not display the completed task.

435088

Export from the Model repositoryof a project with multiple objects failed.

430481

The workflow log does not provide the following information:
- The workflow instance ID

- The workflow recovery options

- The name of the user who runs the workflow

- The Data Integration Service that runs the workflow

- The host node for the Data Integration Service

- The security domain in which the workflow runs

420130

You cannot delete the backup file that the Model repository backup process produces.

354554

When a compile returns an error in the Java transformation and the client operating system
default codepage is not ASCII, the error message is unreadable. A codepage mismatch occurs

between the Java compiler and the Developer tool.

UTORICERESNIHREREZRLET,
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Description

441236

If you update the password for the workflow database or for a database that stores exception
record data, you do not need to recycle the Data Integration Service.

437400

When you create a non-master Content Management Service on a grid node, you do not need
to create a Data Integration Service on the node.

Live Data Map DfEH I N7-FHIREIE

UEi O E S NIRIRERICBL TE. UETO U U —XDU ) -/ — bz THERSIET L,
UToORICEESNIFIREEZRLET,
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450070

Live Data Map BEBEDUY —XD [AXZLEM] 2T THRALEYD [ZFONT— ] #
T arvEERLTLWARWVEED. hRZLBELNA TPV MCERIN S,

448258

IBM Cognos UV —REfREL. [X4F7F—200O0—R&EE] 270 [A>FT>V] 714—ILRED
BEZEETZL. [AVTYVYDER] 44 70JKRy I RIC. 20UV —XBICHISERL
T4 —ILRHBIRFEA L L TRRINERL,
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446979 | Informatica Administrator TlRAE—TH A XEZZETI A\, Informatica Administrator T
RARe—TFHAX%ZEBMNTRE. TT—AvE—JICYARN PPV — g3 U ENTE#HTE S
EhHREINB,

445971 | VS RATHAOQT Y —EXEENILIERICEDOY—ERXREBMIITR . XFvF+HITX
R TRE LRV,

444043 | DY —=REERL T T—F XAV ERELBVIBE. 20UV —IDBEMHRUY - LT
REEINB, LiveDataMap ICT T — X wE—IDHRRINBVHD. BERT 1 —JL RHRIES
nEzthA.

443586 | EHDRAF—I FHRET—EAR—IBEEND Hive VY —REERT . 7OT71U>Y
X v FORTICKHT B, Hive 7OT 71U VT XAF ¥ FTlE Hve UV —XRNTERDOT
—AR=EHR—FLTLWEHA,

442135 | Amazon EQ BRED Y T RR—=ZXF7F7OA4 X2 h T, ApacheSlider iZ& > TF7OrEN3 7
TVr—=23 Y —EXTERTZR— FOEEZIEE TSI BV, ApacheSlideriC&»>TF 70O
1EINB 7TV —a>F—E XTI HBase. Solr. ingestion B DY —EXDNRHD 7,

Metadata Manager D& S N 7-HIEEIE

Ui ofE S NIHIREBERICEAL TE. MFID) ) —XOU Y -2/ — bEIHERBIET WV,
UTFORICHEETNIHIREEZTRLET,

CR HL:

458778 | ARBLVY—RIZEEFNZ ATV CNOBEAZOT ATV b ziRET % £ Metadata
Manager B’ ISEZELETE N H B, COREICHED . mm.log 771 ILIC NULLRA V&
BIADRTINET,

455538 | Metadata Manager 9.6.1 HotFix 2 Zf > T Informatica Platform VY —XZO—R§3 . ROI
5—75{§=\é$3'50

Arithmetic overflow error converting expression to data type int.

452728 | Informatica Platform UY —XDYBF—2 A TSz bDT—R2U =T allid. 7—2 U x—
Jald—AATH. YEBTF—FF TSI P ERBTEIT—ER—IXT—TILOBOXRNER ) >
IHRRINB,

452568 | R XA 2T Kerberos BREENMMERAINTWVWBRFEE. L=ty FEEBNEENZETILIVUXR—
771 EAVR— T BEHRKT S,

451565 | TAILRA—RFXFZFE>THSLBAZEEEL TLS SELECT XHRX FINTULS INSERT
INTO 3XH' CREATE PROCEDURE XICE £ TULWBIHE. Metadata Manager T IBM DB2 for z/0S
AT RIOS=DOvDTF—2UR—Ja Y IRRTINEL,

451561 | Metadata Manager T 7—4Z7—JILICEATS BMDB2 R b7 RO —SveT—7I
MOT—R)R—=Ta ) Y IRRRINAEL,
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451102 | UV —=RIS. HDFSY =R 7 7AIIUD ST — 2 ZHmAWMOTTHF RN T 7 IILICA—RT BT Y
EYIhEgENZHEIX. PowerCenter YUY —ZXDO— RIZKDT—ER—XITZ—TKKET 3,
Invalid length parameter passed to the LEFT or SUBSTRING function.

451067 | Ea—FEHIC INTERSECT. MINUS. F7ci& UNION DERENEEFNTWVRIHE. Metadata
Manager T. Netezza Ea— Y ZDERTOT—IEOT—R2 ) RX—T a2 ) Y IORRRING
Lo

450939 | Metadata Manager IZ. Teradata T— I EMBT I E2a—DEDELLHEVWTFT—RZ Y R—T 2
D> ohRRIND,

450048 | YV —REEFIHFED SQL VT UNEEFNTWVWSRIHEE. Metadata Manager ICI&. PowerCenter
V—REMFLT—ER—XT—TILOED ) > I DRRRINAEL,

449349 | A FERICEMT, BRTF IV D ST —RUR—JanheBIRd 356, 7—2 U %—
CaDERTPALIS—TERHRTEZeHH 3.

448410 | VY —XDO—RAIZSQLN—H—TXEV ) —IHRET 3,

446454 | INSERTINTOX TO AR A—RFXFZFE>TEREDOA T LZEEL TLBIHE. Metadata
Manager T« CO INSERTINTOXZBL AT RO =S vROT—TILICHTET7—2 =%
—Tal) Y IOPRRRINGL,

446428 | TP U FED 25 NFEBRBHBE. CSYDDE IMEAOAYN—FTARZ LYY —R%O
- FT%EL\O

445726 | SAP & DFEFMNER/NT XA — 2 TIEEIN. NIA—FEITNIXFENEENTULZHE.
Metadata Manager T SAP R/3 7—7JL& PowerCenter £v > 3 YD T—42 ) 2—2 ahKRR
INEV,

445156 | 7=V = aBOHYA XD Web TZTHICE o TAZTTERIHEIE. 2OT7—2UR—Ta
Boksrb & Sl S

443675 | Metadata Manager B g RT®D JSON 7 71 )Lz 3l L 728 IZ Cloudera Navigator 7 7 £ X R
AlICH > 7=, &. Cloudera Navigator Y'Y —X&ZO— R TEF%L\,

443602 | Metadata Manager Tl 7Y TR MU —LEA IV A M) —LOREZRITZF T FDOH
M1000ZBR 24T FOFEDH I ERRITIRL,

440560 | AT 3T —2 Yy FBLVR T RO =2 v ZFDED PowerCenter UY — X EREFIC
O—R¥g2L. ROITS—TKHT 3,
An error occurred in LineageGraphInternallinksCreationTaskHandler

440343 | Ny =NV —ROF T U bEFERL T Microsoft Excel 7 7 1 JLICT Y AR—
FL. ESRRGBERIZHDRZLEEOVWTNOZEHRL T, €0 Excel 771 I EZBA VR—
Fg28. RDIZ—TA VR— BRI IHEENDH S,
I/0 error.

440298 | Ea—@D 1 DTHEDSQLZIVIZELD IBMDB29.7T VY —X%ZO—RF3&. Evay
S_M_ALLDB_VIEW_DEPS_EXTRACT B RDI S —TFHETIRT T3,
FATAL ERROR : An unexpected condition occurred in file [<path>/tpordvec.h] line [95]. Aborting
the DTM process. Contact Informatica Global Customer Support.
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439624

JL=ILR—=ZXD ) > H TViolation of PRIMARY KEY constraint (XS4 U*—4l{00E&ER)1 T
T—TRTIBhH 3,

434669

Metadata Manager ICI&. Teradata kUH Y. €D MUADBEERITONTWVWRT—TILE DM
DTF—F)X—=2a) Y IRRRINBV LA H B,

426758

Informatica Platform 10x UY —XRZER LIZHFE. 77U r—>a3> NI X—F2Ey bl B&
UIwEYVIHER) X MIRRIINZ ET 5 WU LOREAAIHDIDZIBELH B,

PowerCenter OB S N/-FIRBHE EEINT-IL

G5

UEiOE S NIRIRERICBL TE. MRV ) —XDU ) -/ — b Z TRERSET L,
UToORICEESNIFIREEZRLET,

CR

i

462936

ODBC ZONA A 241 FD Microsoft SQL Server % 5« T %EA L T 64KB B X 3 ER
T—REHAEB . PowerCenter IS —E XD ERT — 42 % 64KB IZY] B 558 %o

460190

ODBC ZONAH B A TD Microsoft SQL Server 21 7« JEFZERL IS —OJ57—JIL
ERET B L. PowerCenter REH —E XN T —TILDIERICEKK T 3,

456700

Workflow Manager @t w3 >7O/NT+ T [BRIAARICTS] A7 arvhiRrIng
LYo

456698

D—070—%ZE—93NT—J7O-NFENZTAINEFETTOITRILE Z—7 v
RURD b UICERT SR BVEETE, KETSEMZIE—TES,

455493

V—RATF—=RILT7 7t FEERNIOXENSENTVEIEE, F—V XXV I/ 5FEHATZ
VPN N E R

454526

ODBC ZONAHH A 7D Microsoft SQL Server 21 7« J#EfiZzERAL. AT RT7OS—-
YRS URT =A== 3V EMERLTINAFUFT—42% Microsoft SQL Server ICHAT 3 &
PowerCenter i —E XD NULL T—F2%2O— K $ 3,

452722

SQL S YR T#—X—=> 3> TSQL I I ZRELTHESE. Designer A FHE T vwv b4
N I

452688

VRS RIICY—RA Tz bADII—rAY RDHFENTVBEHRE. VRS HUDT Y
TIL—RHRET 3,

452208

9.6.1 HotFix3Z A YA R—JLFBH 961 HotFix3ICFwFHL—RFBEE. Web Services
Hub Z{ERL TE %L\

452195

V=ABLUVEZ—4FvY FEEE IBMDB2 N—=2 32 10506410 VR—kLEEIC, charB2E &
UvarcharBOHh S LOBEDNRIEIZR 5,

PowerCenter DEEE I N HIREEBE ERIhnF 29
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452148

Web H—EXOQAY>a—<IbS VR TF—X—=2a>YDNARXI—FKR—+O&FIEZEELLS
9B, Designer "FHAE T vy EEDVT B,

450904

FI7ANLELONY T 77Oy oA X %P LT, ClobTF—2BDAZLDEENS Oracle V
—ZANBEREDT—EZHAIMBE. Ey o aryhFHET O vyy FEU VTS,

450310

FIACRICA TS U b ERIEL 7=%IC. PowerCenter YIRS U —EXDEZ =4 v k1)
RO PUTEYY 3 YDREFICKKT 3,

447202

F—=y PURIS MR TEZTTAMRY I =TT 7O+ LRI V—IURD b+
DD SHAR TR TA TV FHEETNB L VWSKRERI S —HREIN S,

445137

Ly arvERET DI, Workflow Manager TEw S a>YOREOAT AT Y MHREREIN
BB,

444347

F7OA%. 79— 70— FTP A —/N—5 1 RHlkbn 3,

442228

pmrep T T—7INEDFEHIEIETH B xml D1 > R— MMIKKT B,

441033

Web H—EZXHUb BRI SA T Y RBERTF v IXvE—C2UEBTZEE, WebF—EX
Hub A' SOAP ER DB ICKK Y B

441020

J—270-%41>R—k L. Workflow Manager DX v EY I AV REV A6 -0 70—
I LRI, T5—HMRET S,

439129

pmdtm 7O AW RIGLARWRETH 5 & F. PowerCenter UT7IILEA Lty 3>d CPU
FRERNEL B3,

432803

=Ty bDFy a8 ORBILEEAL. ERINIT) T -0 7O0-ZHHER
TNTWBIHE. Evarhkld 3.

422219

DSN ZDHEBEHIBIETH DY — XA TSI bDA VR—MEHT 3,

399328

Ly aYANIUEBRILTEZRIZBEFH T I FSoYF o g a>rO-IL bk
TURTA—=A=2 a3 EELEYIa AT S—TLKT %,

UTORICERESNIHMRERERLET,
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452530

Microsoft SQL Server ##: CTONA A 21 T% ODBC ICRELTE—4' v bTF—TILZTDEE
HBFE. PowerCenter REY —EXTRIICEZ =7y bT—TILOYIDEH AT RARTTE
N3, YIDEH AT RBKBLTBEE. PowerCenter i —ERIFHIBR AT REEITLE
To CHIZED, By a>onNT7+—I>AHREELET,

205998

pmrep CreateConnection XY > RZFERAL T FIPEHKZER TSI 3,

203376

pmrep AssignintegrationService Y > RZ{ER L T PowerCenter it —EXICT—2-70
—ZEDHETBILNTE S,
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IL—=IL LR DEEE T NICHIRSBIE € RE S NTHR

UaiofE S NFIBRERICBL TE. MBIV U —XDU ) -/ — bz TR FET VL,
UToORICEBESNIFIREEZRLET,

CR

B L

461876

W=D 53y Ly b ZERT D LI, Analyst V—ILBNIL—ILIE#kD&FTIZ FL T 1 v
IR LTTSaRVIL=Ity Oy FLy MIEBIT 3.

451736

ALYA—ANTHNZRIOBNASLEZTILEZYYTFTBeE, BIRLCAMEZOR
HoLd—RH Analyst V=L TRERIND,

450139

=Ltz I NAIILT RS £EFLIcyy 7Ly b T BLRZATIOMDIL—ILAERDOT
v 7Ly b EBESTINBHEDH B,

444287

=L X —=FICE D Analyst V=L TYIORRI U T T 1 VT DBEELEL Z5HE
h#H 3,

4447972

BIASENS XA —ZIZED, Analyst V=ILTHOARRY ) FF 4 VT DFBELEL BHBEH
H3,

442115

2 DU EDIIL—ILEEEBEC . Analyst V=L TRAIIDIL—ILAKRD by LA 7ONT
1 DHHRTINDS,

441397

=ty bEELIFFHBEZAAL. 7T—IIR—IATHDOIL—ILEY FZBIRTZ L.
Analyst V=L TAALTETF A MDHEINS,

441358

=R TOEBRTONT LD, Analyst V—ILTOZORRI U FF7 1 VT OHFGHEEDE
L3imah'H 5.

440755

1 EIDRIETHNZZRIDTRTDR—S THREDIARTOA VY AEZ Y X% NULLBEICB#]RT S
ZEDTERL,

440742

1 EIDRETHAZ R DIREDR—S THEOTANTDA X2 X% NULLEICE#RT S C
EMTEIRL,

439753

MOZXBENYTIEEDIES., F—LR—IBEREEENETEEEDICHEEL AW,
- @FEELEENZIA—Y—FEFEAL T Analyst v—=)LicOsd 1> L1z,
- L= EER L .

437273

TN LOBEDEH ZINTHOBEMCELRT ZFNL - F2XITIE. BREE®R
FFarvEFERTIEY,

435347

RDBFEIC, Analyst V=L THRNZ RV 1BV S REEZ RO D [fRE] RE2UHEMCHRD
BELH 3.

- BRUEBRW

- FDORRVEFEFELT Analyst V= ILEEHF L=,

416858

Analyst Y —=ILDBERIDEI FRET—REZ LIV AR— T3, TIVRR—FLEIFTRE
CEEMITOSNTVWRVWI SRXEDMT -2 T AR— M EEICEEN S,
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436796 Analyst Y=L THINZ ZTICH T 2 1EEE TS HE. o1 —H—hEKEY> 3 > TRLEA
RN T REEEITS EDTERL,

408224 BINZ RO TEIRLIELO—RDOEY MCEENZT—ZICH LT, RERES K OBRIZE
®RITTE S,

Y — RN—T s Rm THEESINIHIREIA
Ui ofE S NIHIREBRICEAL TE. MEIDV ) —XOU Y-/ —bEIRERBET WV,
UToRICEBESNIHIREEZRLET,
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438011 Red Hat Linux N—=3 > 7.0 ARL—FT 4 > J AT LT, Teradata ODBC ##tiC Kerberos
RELERE LB E. BRICKRT 2.
Teradata ¥ 7> FBERES: RECGLTTAL

424900 Sybase T—RA TPV P RAF—TZERT D xsd T7 T IDSEESINIRET —2FTY
TV FETINEREET A RIS —DRETZCHHD. RWAITS—ICIF. BEET—4
BOR—HHALER— I3,
MITI DEFIFES: INFADEV-41
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TV =23 Y —EXROBMOFIREIE, 35 XR—
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Administrator YV — L O EERI DO #IPEEIE

UTFORICEIMOFIREEZRL X T,

CR HL]]

452798 Sqoop ZRAL TTF—4%Z A VR— b EEI I RR— T 3HBE. Administrator YV —ILD
[BER] 2 JICHRITHIADPEL K RIFTNAEL,
BB yarn O TEITHETZHEL T,

440143 Kerberos EREE# AT 3 K X1 > DIBE. Administrator V—ILD—EBDOE 2 —T. ARL—%
O—IHAEDOETESNATVWERA—HF—ICRDOAvtE—IHRRINS,
ETINURIS PIDRESINATVE A, BEEIEELTLIEIL,
CHUE. EFIVVRSMIBRESN TV THDRELE T,
EEE BERBICRESNIEETILVARS FU S —EXOBEBEO-IILEARL—Z1—H—F
ST NL—TICEIDETEY,

438332 Kerberos SREE# T % R X1 > @ Monitoring Y —IL@DFE. [AFT7 U ] XZa—Ta1—
#—H Monitoring YV —ILA 5 AT 7T LT N7EL,
Bl Monitoring Y=L\ O 7T L $3ICId. T30+ RUZBLET,

437717 Kerberos BREE%#EA T 2 R X1 Y DIBE. v a > OBFMERHIYIN /=& IZ Administrator
v=llicOg1 >33, [BE] &0 [®FZ4] 2710040 o R=IHBREINBZ D
H3,
EEEER: Administrator Y=L 60O 7T LT, BEOJ1>LEY,

436587 J—RERXAVIZBMIETH S, Administrator V—IL T/ — RO FONT 1 BRRIND
£T10~15#hH 3,

429227 J—Ro [AJ73Lo>a>yFq«LobI] 7ONRTo2%ET . [OFaALov>a3>F«
Lo kU] ZONTaZ YT TERL,

Analyst Y — )L D EEFN D HIPREIE

UToORICEINMOFRERZTL XY,

34

CR

Bl

460405

D BERFTIHMER I NS Windows & w k7 —2 T peclientsmartuser R LTI v E> I+
¥k%Z PowerCenter UIRS MUICIVRAR—FL&SE TR L. IvEYTHKRDI Y XR— b~
MEREY B,

INFAKRB.INFADEV.COM ZER L TY v E Y J % PowerCenter URI K ICIT Y R7R—k
L9,

421325

BRT-TIOEERRL. EVHETERLISETI L. Analyst V=ILBEELK HAWVWIS
— XAy E—U%IRT, TEDIT—AvtE—JF BELIEBRRENBBT—JILIZEEATL
BOWCBMLET. COBEIE. IBELEBREBICFRASINTULWAREN 8RT—42H7 L4
KL TEITRIHEICHELE T,

396636

MOI—HF—HEELLTEY FEHIRLESE LIS Analyst V=L TR, ZO7EvY b
DPRIRTIIBVE VWS EERRTINEL,
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UTFORICEIMOFIREEZRL X,
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459892

F=RAREY—ERXTARL =T VI RTFLATOAT 7AILDIVE Y T %2 EFICRITTS
. XEUDNBEICERAINS,

443052

ROFZEHYUTIEFEZFBE. 7—JT7O-IVvEYITEZIIICEEFNTVWBRIYEYSDDIM
|:|77 7N DIM 7O X TERINAE L,

F—RABEY—ERIZ. BHDO)E—+TOELR T3 TERITTRLIICKRETNTLE
ERS

- D=0 70-RRvEVIRIAIVICEFNTVWEBIYEYITTIYILFNA FXEHERINT
W3,

442102

BFA—IY—EXTRFEZHAYR— TN TOWRWEATH, BFA-LTF—EXD [F
At ] 2T ICRREH LV avHRRIND, RIBEHZEBMI S, BEFX—ILY—E
G ZDRERHZHERLET,

441281

BERDOYE-—FFOERTY I TERTIBLSICRESNET—EMET—ERIUYRT
BHROTYEYVIZRAKBICEITIZIHE. FV21TLBRHERETBLSICETILURI LY
PREThTVWEVE, —BOIYEYTORITHROIS—TRETZZeHH 3,

[ICMD_10033] Command [runmapping] failed with error
[com.informatica.ds.ms.service.MonitorHelper.purgeStatistics(MonitorHelper.java:125)

439632

RDEZUHYUTIFERBE. Vv EVIOHEOT I 7AIICELL BAVWDTM O 7 71D
aihé EhH B,
F—RABEEY—ERIZ. BRO)E— ORI T3 TERTITRLIICKETNTULE
ERS
- RYEVTEZRIVDRFETIYvE VT AR IO 771N 2R ETRLSIC7—or 70—
DIVEVITARIDEREINT WS,

EEE 21 LRRZYTTIYYE YT RAOO 77N ERETZESICIVE VTR I%
RELETY,

439628

ROZXEDEUTIEIERZBE. T—EHMET—ERT Uy RTRETINZ T Y EYIHELRRIC

/\/7T% EhdH 3.
F—ABEY—ERIE. BHDO)E—+TOELR T3 TERTTELIICKRETINTLE
ER

- TAREY—EXREMIRD., YREZHE/ —FHRBIREINIEEBTIY —AIHR—T ¥
H—EXDMERATERL KRS,

B VY —AXRX—JvH—EXZEBYCLT. IvEYTOERITZHRITLET.

436753

F=RAMEY—EXT VY RICEIDYETENTWS /- FOHEO-ILEEH L. T—2HE
Y—ERXREUHAIILTB L. Informatica V547> MY —ILEATEEN—BLEVWZ EHH
%0 BIZIE. T wEYIDORTH infacmd ARV RS04 > 7055 LTIFERRT BHN.
Developer tool TIFMINT R WS e HEID FT,

BB KXV EBEHLET,

435471

Kerberos KX > DBE. BRIOUE—F7OEATY 3 TERITIDZLSICRETNTVLS
F—=AREY—EXT VY RTIVE YT DRITICEKKT %,
EEE ERoO—hIL7OEX T a7 2RTIT3LIICT—FRET—EXERELET,

432752

RXA Y TREBRBEIAEMICHE>TWVWBRDIC, BROYE—FFOEXTY 3 T2ETT3
ESICBRESNI T —E2BEY—ERT Uy R a7 AEREZFERALTUE—FDIM 7O
TREBELEL,

FIY =253 > —EIDEHIDEIREE
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432316

BRD)E—FTOER T3 TERITTELSICKRESNET—EHEY—EXI VY RT
JvBEYI#RFTTRL. inffacmd ARV RS> 7O LYvE>YIOFTIvEY S
BEBLIZCENRINTULTH. Administrator YV —IL®D [EZ4] 2T DI v EVTREN

431534

RERELLANILTO—RIEFOHNEFRTZLS5ICVNVYEVIERETR . T—2HE
H—EZXPIRX MR- ORFCAXEBEBRLEL,

427052

F=EREY—ERT VY RTWeb H—EREBREZRTIZBE. F—EXRO—-/LLHEHRL/
—REFEATBIESICHABHTITPO—RNS YUY ZEB-TRET I . T—2HEY—EZH
SH—ERO-ILEHEO—ILOEmALN DB/ —RICERNKULIL I FSINT. H—EXO
LD BV —RIZT 1 ANy FINF—EBD Web H—EXBRHIKKTZ e h'dH B,
EEE —EXRO—JLEHBEO-IILOmADH D/ —REFHETZLSICASHTTP O— RN
SUHERELED,
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PLAT-872 | SUSE 11 T MapR5.1%Z&EL. Hadoop 75 RZT Sqoop ¥wEYIZRITTH L. ROI

9 S—TIYvEYIHEET 3,
com.mapr.security.JNISecurity.SetClusterOption(Ljava/lang/String;Ljava/lang/String;Ljava/
lang/String;)Isqoop

PLAT-871 | Kerberos SBSENE#N% SUSE 11 Hortonworks 75 22 E® HiveServer2 TY wE > I % R1T

4 TR, MySQLERI) — D REEL. RDIS—TIYVEYIHERT 3,

[HiveServer2-Handler-Pool: Thread-3439]: transport.TSaslTransport
(TSaslTransport.java:open(315)) - SASL negotiation failure javax.security.sasl.SaslException:
6SS initiate failed [Caused by GSSException: No valid credentials provided (Mechanism level:
Failed to find any Kerberos tgt)]

FRRER: MySQL ) —V OREBFKZ RS T N TEE T, CDRSHICIFE. BigData
Management REL—T « )71 ZRITLRIC. hive-sitexml/hdfs-sitexml 7 7 1 ILRD
hive.server2.authentication ZEINT « 8% NONED'S KERBEROSICEEL &Y,

<property>
<name>hive.server2.authentication</name>
<value>KERBEROS</value>

</property>
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EA

BDM-741
BDM-692
BDM-691

Hadoop 25 RAT Spark TV e DI vEYTZETTIL. ROIZ—TIvEVIN
MY B,

[org.apache.hadoop.security.AccessControlException: Permission denied: user=<USER>,
access=WRITE, -

Bl Spark MYV EY I ZRITT R IICA—F—2BYNIFRIAET BICIE. V5 XX TE

MOBENBETT,

Kerberos JEMISY 5 X% 0S5 X2 TEREEIC Kerberos ZEA LA WSS, Hadoop BEEEIC

ERLTROFIEERTT DL SEBEL TSI,

1. /<Big Data Management installation home>/services/shared/hadoop/
<Hadoop_distribution><version>/conf ICREIL. XD FO/NT « % yarn-sitexml 7 71 JLIZE
MmLET,
<property> <name>fs.permissions.umask-mode</name> <value>002</value> </property>

2UVZAZEEBWeb 1V T T —XATHDFS HT—EXRER—CZ BRI 5D, hdfsxml 7
7T ZREIET,
superusergroup ZONT 1 ZRDIF £, dfs.permissions.superusergroup F7zld
dfs.permissions.supergroup £ W5 TT,
zROJ:L H#—% superusergroup 7ONT 1 ICEBML £7,

FT—AREY—EX 7Ot R A —F i3l —
- YARN 2 —H—
RYvEYYITHDFS 24— v b EFERT 35613 HOFS it —H —,
EIVEYYITHve Z—7y b EFERT3HE. HDFSERI—Y—ZEBMI 3HEF
HOFREA
Kerberos ¥i59 5 XX Kerberos T 2 A2 DEBEILBE. V7 XFADIRTD/ —RT
BEI——1—F— LTEMILFT, ChULOEEBRIIVELD £E A,

461622

IYEYITHOEBRD RS VAT 4= X—=>3 YR SFTVT. ALEREFIL I 7ILET:
IEDEFETILI 7AIDEINDZ . Blaze BEBTIYYE YT DORITHEKT B,

461610

F—=RZY =AM Hve V=X T, B> FUTF T3> LT [TARTOIT] #EIRL.
Blaze TV T7AT7 7AW ERITIBZBE. T—F XA VBREE#SHZLTOT 71
ILHERT B,

B I IF T a3 e LT [TV IIBRAD]. [SYFLBTIVH]. £
=ik [SE4LHYFVYS (B8] #BRLTIO7 71 ILERITLET,

461286

208RY. FEBICHVWERT Spark TP TORYEYIZRITIB L. IvEVIH
OSGI TS5 —THKRMT 3,

&R T&eclipse.stateSaveDelayinterval:20001 & W5 7% X k% hadoopEnv.properties 7
7AILDRD OSGI 7ONT 1 DIEICEML 9,

- infaspark.executor.osgi.config

- infaspark.driver.cluster.mode.osgi.config

461044

Spark LYY TR EVIERITIRD L. IvEVIRITAAVNAINIS—TEKRT 3,

FEHR: 5 XA T Informatica Big Data Management IZf3B 9 % Java AA D Java D1 > R &2

YAMRMERATNATWV S,

[El##5R: Big Data Management & —#ICA YA b—ILEINB Java DA VR E VA EFERT S

LSV FZREERELEFT,

1. JAVA_HOME Z#% <Big Data Management Installation Home>/java/jre ICEREL £9

2. JAVA_HOME/bin B ZRD &L SICREL E Yo
PATH=${INFA_HOME_BIN}:${JAVA_HOME}/bin:${PATH} export PATH

Z D%, Informatica RXAVBLUH—EXZBEEHLET,

460997

I—H—ABRERE L. Kerberos REEZFRA T % Hadoop V5 XH T Sqoop NwEV TR
793 RyEVIHEKT B,
Bl Hadoop #&#t T Hadoop H—EX TV VNI BAZFERAL. YvEYIZETLET,
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460915

Blaze BT, W—FT 4> a tThTVWRWIL—S3FILY —INEENBET—HEIRF
VIRVEVITONRT =X ADMET T 3,

460889

TEZ TP >%MERAL T Hortonworks T4 AR E 22— 3> TRITTS Sqoop ¥vEVY
DRERD HEF LS VR T+ —AX—2 3 Y TELLERINEGRL,

460640

Big Data Management |& Java 1.8 Z{E 9 % Hortonworks Hadoop 7 5 X4 %&HR— kLT
W3, JFRXZT JavalT BMEAINB L. Hve IVIVEFRALTETLETYEY D
KHT D, ROLSBIZ—DRRINET,

Unrecognized VM option 'MaxMetaspaceSize=256M'
Error: Could not create the Java Virtual Machine.
Error: A fatal exception has occurred. Program will exit.

EEE: XOFIEEZRTLT. T—2RET—EXZERI T 3RET> > T Hadoop 7AIN

TarERELE T,

1L F—2HEY —EX%ERITT 5 Informatica Big Data Management REDRET> > T, X
DI77AINERVTHREL X,
<Informatica installation directory>/services/shared/hadoop/
<Hadoop_distribution_name>_<version_number>/infaConf/hadoopEnv.properties

2. ROITERDIF. FLBICHFZEMLTIOXY R TIURLET,
infapdo.java.opts=-Djava.library.path=SHADOOP_NODE_INFA_HOME/services/shared/bin:
SHADOOP_NODE_HADOOP_DIST/lib/native: SHADOOP_NODE_HADOOP_DIST/lib/*:
SHADOOP_NODE_HADOOP_DIST/lib/native -Djava.security.egd=file:/dev/./urandom -Xms512m -
Xmx512m -XX:MaxMetaspaceSize=256M

3RDITERDIF. FLHBEOINFZHRLTIXY MERLE T,
infapdo.java.opts=-Djava.library.path=SHADOOP_NODE_INFA_HOME/services/shared/bin:
SHADOOP_NODE_HADOOP_DIST/lib/native: SHADOOP_NODE_HADOOP_DIST/lib/*:
SHADOOP_NODE_HADOOP_DIST/lib/native -Djava.security.egd=file:/dev/./urandom -Xms512m -
Xmx512m -XX:MaxPermSize=512m

460412

Sqoop ML TTF—4% Oracle T—ER—XICTVAR—FT3L. FEORRATIVE
VOHKKE B, COMBEIF. ROFXEDIRTHTIIHEIZIBRICECD FY,

- EE5IHEREL T O0rabop ZFEAL TV,

- TR float T=RBD AT LHEENATWVS,

459942

Spark TP YNNI Sy T FAIUNE—y FRICRESNAT v EZ—{TOY VY FERTLA
kI\O

459671

Sqoop ZBHALTTF—HX%Z IBMDB27/0S T—RZNR—RXICT YV AR— kL. Ny F5|8=HRE
LBRWEES. Yy EVIHEKT 3,
Bl Ty EY I TNy FeleREL. BUIYEYIZEITLES,

458238

Wy o Ty ITF—=FICNULLEBEAREFEFNTWR L, Spark TS Y TOIL Y I Ty FINT 4 —
I YADEEICETT .

457397

Sqoop EEAL. NREZLYTU TRARKEERTHL. Ty INERT 3,

457072

Sqoop ZEAL. BLEBDASLNEEFNZ 2 2OT—TIUEHEETZ. xvEYIH
KT 3,

456892

Blaze SV A A LEBEBTHive =4y b TF—JIILEEREIZEBRT B DDL RV S hiE
BRLTERITIR . YvEVIHREKKT 3,

456884

Sqoop ZFERAL. RADIYN—FRAINPKRRT B L. UEDOIYN—RXIDRRDITZ—
Xyt —IUTRERT B,
T7ANMETTICEELTWET
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CR L]

456866 Developertool TIFEE 7 71 INA T TV T Avro T—28% Avio B R— b LABEWVWT—
SEICEBETIZ . RTBICIVEYITIS—DMET %,

ELEE: Avio T—RBEZFTIHA. HR—bFINMTWVWET—2ETHZ I ZHRLTL
EE W,

456704 MariaDB JDBC RS /NZ AL T. Sqoop TAurora 7—4ER—ZAMNS5T7—4% 1 VR—k
TBE. RvEYIDNIEEERFLET B,

456616 Sqoop ERELTTF—4E TV ZK— kL. 751U F—ERHIHZHE. TvEIIH
KL, FRLO—FHRRRT 7AILICETRAEFNA L,

456608 Sqoop AT BT —2A TV b EEHL. 7—2F TPV b ERBALTH. BFHA
BN Sqoop A Y AR— ATV RIZEEFNAL,

456455 WEBET—FFA T MAIC Sqoop ZBMICLTT—4% IBMDB2 T—42AR—XIZI YRR
—R¥BL. Sqoop LY RK— AR RHEMT 3, L L. YyEPYFIEIS—HLT
EBICETEINS,

456285 Sqoop B L TTF—4% Netezza T—ER—XICTY AR— kL. T—ER=XI float 5
—FEOAITLNEENTVBEHE. YYEYINRET B,

455750 oraoop-site.xml 7 7 1 JLTERE L 7= OraOop 5|#H* Sqoop THAEWS N,

B < v E>J T OraOop 518% Sqoop 518O—3 LTEELF T,

453313 Spark TV Y THBORKIYEY I ZRITITHE. NTF—IVADMBTTIHELH
D, O XyvE—ITNDY—ABMEATERVWERINDG, T—EHEY—EXTIE. YvE
VODRERE VS RAZATERITIRTH > THIVEYITHEKBMLIEERE NS,

453097 T—R2FTT U FRAIC Sqoop ZEA L. BEMITONIHAMD £/IFETAA LIV
TH—A=2a>VTEOTONTAZBHITD L. YvEYIDN Vector T —Xyt—IT
795,

EEE FHFLWTF—24 TSI b ELUVIVEVTEERLF T,
452819 HDP & & T CDH SUSE # 5 X4 ET. Snappy EEERT 3T v EYI6L0707 7170

H HiveServer2 €E— R THRET 3,

e -

Informatica RXA YT, I9S5RERZAT4TSATSVDBAMNEENZ TAONT 1« 2iRE
L9,

LROT7ANZENY I Ty FLTH S, AWTIRE L £ <Informatica Installation
Directory>/services/shared/hadoop/<Hadoop_distribution_name>_<version_number>/infaConf/
hadoopEnv.properties

2. SHADOOP_NODE_HADOOP_DIST/lib/native ZANT 1 ZRDlf. TDEZ IS XAZZA T
17547 )DBRATESIRIET,
Hortonworks o l:
Jusr/hdp/2.4.2.0-258/hadoop/1ib/native

Cloudera O HI:
/Jopt/cloudera/parcels/CDH/1ib/hadoop/lib/native

Hadoop ¥ 5 X% L:

1. HiveServer2_EnvInfa.txt 7 71 L ZBVWTIREL £ 9

2. <Informatica distribution home>/services/shared/hadoop/<Hadoop_distribution>/lib/native D&
HISABZATAT AT SUDBRICEELEY,

3. HiveServer2_EnvInfa.txt 7 7 1 JLOABZIE—L £ 9,

4 hive-env.sh 7 7 1 ILZBIVTHRE L. HiveServer2_EnvInfa.txt 7 7 1 ILO TR TOABZEY
DRHFET,
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452224

Tez TRITINBIYE I THI U BLUFHERRADEICR S,

452114

T—RFATT U MBIC Sqoop ZEMIC L. TR FIEH T L%KIC Unicode XFEHE
ENTLRHRE. v EYITHRKT B,

450507

IyEYIRKRBMLIEEE, Spark TV Y TIY Y E VY IRITHICT — X DBMICER I N
—BA Hive T—TIILHEIRINAEWV, T—TILEZFETHIRTZIZLIETE %,

443164

@BRD)E—+7OERTY 3 TERTITRLIICT—EFHEY—EIDBREINTWVDIF
B ROVWTNHDY — XD SHRAMB I Y EVTDRITHRA T TRETERKT %,

- Hadoop BEIZ7 7 ALY AT L (HDFS) @75y b7 7ML ERIFEET 7L

- HVEF—7JL

- HBaseT—7IL

E#%: FT—E2MET—EXDHEL 2 —T. HEO-ILDOH B3R/ —RD
INFA_HADOOP_DIST DIRIRIBEZREL F7, REZHICZ. T—FHRET—ERD [T—
AHEH—EXD Hadoop T4 ARV E2a—>3> T s Lo MI] RITATOaVICRED
NTVWEEZRELE T,

440423

ODBC #E#Hi 2 FA L THRET — 4% Netezza T—EAR—XIIZEZTAT ., IvEVTICKRRT
%o COMREIE. Clouderabud TIYWE VI ZRITITBHRICERELET,

437196

ET77ANATSIIRDUY —RT7AINDINRAD, IL—rF o LT YU THREDXFT
TROZ3T4LI7M)DOBRNIELTRRIINS,

424789

ABS B L IIF 8 HA Y % Hive V—RBLUVEZ—7 v BT T v E VI H Hadoop R
BTRUT B0

422627

Hive V=&, TI7A#NLEDTF—TILEHIHHSLEDTL T v IR LTERATINATWVS
T IILEZEBEREENTVWB L., Hadoop REBOT v E VT ICKET 3,

EhEEE: 7 IILFAEEERELT. ASLELDTL I v IR LTERAThATWET—TIL
2%HIKRL. YvEYIEBEERTLED,

421834

Hadoop RO AFIIC 128 XFEMERINTWB72®HIC. Hadoop BEBOT v E Y JIZEKML

o

Business Glossary Known Limitations

UTORICEIMOFREERZTL XY,
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Description

461823

After you conclude level 1 voting in an approval workflow and view level 1 voting comments,
the voting details section of the voting dashboard becomes unresponsive.

Workaround:View the voting details before you conclude level 1 voting,

461624

If you specify the PROTOCOL_TYPE property in the Silentinput.properties file as "HTTP" in
uppercase and install Informatica Business Glossary Desktop, the protocol type parameter is
incorrectly set to HTTPS.

Workaround: Specify the PROTOCOL_TYPE property as "http" in lowercase.
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Description

461308 The Search Service does not display Business Glossary results for a search performed by a user,
if you expand the scope of privileges for the user in the Administrator tool after the indexing is
complete.

Workaround: Assign the necessary privileges to the user before the Search Service indexes the
Business Glossary data.

460458 The Analyst tool does not accurately display the number of attachments in an asset that you
revised, after you import the glossary that contains the asset.

459878 The dock menu options such as Preferences, About Informatica Business Glossary Desktop, and
Quit Informatica do not work on the Mac operating system.

Workaround:

- Click File > Exit to exit the Informatica Business Glossary Desktop.

- Click Edit > Settings > Preferences to edit the Informatica Business Glossary Desktop
application preference settings.

- Click Help > About Informatica Business Glossary Desktop to view information about the
Informatica Business Glossary Desktop application.

459873 The Informatica Business Glossary Desktop application does not automatically run after you
log in to the computer.

458916 When you delegate a vote in the approval workflow process, you can select multiple users, but
you see an error when you confirm your selection in the Analyst tool.

Workaround: Do not delegate your vote to multiple users.

458237 The Informatica Business Glossary Desktop client does not appear in the Mac applications list.
Workaround: Use the Terminal to navigate to the Informatica Business Glossary Desktop
installation directory to launch the application.

458075 The Analyst tool does not send email notifications when the domain is configured with
Kerberos authentication.

457603 When you install the Informatica Business Glossary Desktop on a Mac, the following error
appearsin the Terminal:

INMIHFADWDJWV: Informatica_BusinessGlossaryDesktop_Mac infa$ ./install.sh

Trying to load library IAMac

Error trying to load library no IAMac in java.library.path

Workaround: Ignore the error displayed in the Terminal and continue the installation.
456124 When an asset appears at different levels both on the left side and the right sidein a

relationship view diagram that has bi-directional relationships, the Analyst tool does not
display the relationship levels correctly when you change the number of levels when the
following is true:
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Description

454561

You cannot publish or reject Business Glossary assets when all of the following conditions are

true:

- Thevoting was in process.

- The Glossary administrator exported the glossary.

- The Glossary administrator imported the glossary and replaced the assets that are already in
the Analyst tool.

Workaround: Complete the voting process before you export the glossary, if you intend to

import the glossary.

447739

Business Glossary Desktop does not recognize line breaks. Content in business term properties
that support the long string data type are displayed in a single line.

AR RS>0 5 LOBAMOFIREIE

UTORICBIHDOHIREEEZTRL XY,
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456536 BRI DESRABEEETIERWVBEIC. infacmd wfs bulkComplete IX > RERITLT. 7
—JJ7O0—TEETNZIREZRIZTT TE 3.

451454 Microsoft SQL Server #&#t® UpdateConnection A¥ > R&ZRITT 3 & FIZ. [DSNDER] #+ 7
ave [F7ANME247] 772 a3 VICIBE LIEIERIES AL,

443208 infacmd dis updateParameterSetEntries A< > K £7cld infacmd dis addParameterSetEntries
XY ROWVWTNDZE Linux Y Y TC YDA SERFTLAEBE. TN50IX Y RIC—E5|
ARERRBZES BT ZIEORAL N TIRL,

Bl CN5DOY > R%Z Bash YT ILh S EFTLEHREIEF. —EF|BAREETES AR E
BHALZENTEET,

441218 | REf infacmd ARV RS VD SEHRORR Y Y E YT Z2RTISL. T5—TIvEYY
RITHKRKTE2HEDH B,

435815 infacmd wfs abortWorkflow 3= > K £ 7zi& infacmd wfs cancelWorkflow ¥ > R &2 R1TT 3
EFIC Twaity 772 a Y [wEERTIEAL,
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CR

&II

7|

441291 Linux64 LV AIX64 TZw kT x—LT Informatica AR EZY—=ILF Vv b1V =%
FERETIRL,

[ElEEER: FET Informatica AT XY —=ILF v b Linux £T2IEAX Ty R T —LIZT Y
2 ;=LY BAHEICDOVWTIE,. Tinformatica AT 2V —JLF v k Developer H1 Ky @
Minux £7ld AXAD Informatica ARIFZY—=ILF v DA VX =)L) €3V EBR
LTLIETL,

438209 7 1 LZRIET Datetine T—REEZFRHT I . 7ETEDHAHMOBEEZ T I L TIAL,
[El&# 8% Informatica Developer 75 7> &R L T, Datetine 7 —2B%EZFX ML £ 7,

438203 B LCERIENIANFENXFDRBEIRATA TAET—E AT b2 ET 5. O—
FOERICKET %,

B RA T TAERT—EA T FTUICERBRZ BRI ZEALET,

435998 MET—ILROHZEGEEMEZHRET I . BREMICH L TIThNAZEN T X MEKY
4 PF—RICRRINAWL,

Data Transformation ®EER1 D &R

UTORICBMDOHIREEEZTRL &Y,

CR shEA

455003 BBAADCUL—SaFILEAFERIEV L =3 FIILARDCRBEADH D Decimal38 H
HR—=rBHZ3T—27OCLY BT LSO TH—AXA=avidk. Iy EVIHRET % A]8E
M H B, Decimal38 HAAR— FTOEBEIS UL =3 FIIADRST YR T H—X—
av., ¥fldDecimalB8 HAR—FTOUL—> 3 F IO SRBEAD NS VAT £ —X—
arvb. IvEVIHERTBIAREEDHD T,

B ChoD SR T+—X—2 3 VOHAR— MZ Decimal38 ZFERALBEWVWELSICL
F9,

CM-7722 F=ATOVYH RSYRT+—A—2a3 >y TTF—42% JSON BAICEHTRT B EIC. HIH
XENUXETIXRT—FINE,

CM-7720 HPAASA TS UNy =S ERALET—42 708y SV RT+—X—23 >0
Edifecs N—2a > 6.X T HIPAARREED H R — TR,

CM-7693 JSON BH#EFERALIET—4270E Yy bSYR T+ —X—2 32Ty EWA Unicode XF
HrOr 16 EDERAFTIEBRINIFUEOICESHTEZI 5N,

CM-7692 T=RTOEY B ESYRT+—A—=2 32D XMl AMU—IHB DOCTYPEEEDH B K+
AXY LB TERW,

CM-7691 T=RTOEY B ESYRT = A= 3 VHNF 0~31 DT —4% JSON HAICEHRT B
IS, X FEDXF\U TIRT—FTINHL,
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452731

SUSE 11 T Timestamp with Time Zone 7 — 2B ZFRAL T v EY I ZERTH . RDI S
—TYyEYINEMT 3,

Database driver event...Error occurred loading library [/usr/lib64/1ibstdc++.50.6: version
‘GLIBCXX_3.4.11" not found (required by /export/home/svcoca/ocaagent/perforce/10/depends/bin/
libicutu.so.55) [Database driver event...Error occurred loading library
[libpmtimestampTzexpr.so]"”

443876

Web H—ERXROAYa—I LI VRATA—X—= 3 RESTWeb H—EXROAYSa—<TZ
YR TA—KX—= 3 >H Timestamp with Time Zone T—4&8ZHR—k LAV,

442175

Timestamp with Time Zone T—RBOKEFE IR — b Z2#FFD Java FT VR T+ —X—> 3
VEZBOIVEYTZTLEa—FRIEERITTEAL,

441191

HZ LDFT—ZBM Timestamp with Time Zone MIFE. TDH T LI L THAAHIL—IL
CMEDEEDIL—ILHHEEE L AL,

440559

[RITRE] 4170V RyIXATT—2BRAZHELTVWEWD E—FT Y T 7ILT
Timestamp with Time Zone XX EEL TLWARWEBE. T—42HREY—EXDRARIHT—42t
v N DEROERAPUICS VA LTITEES T %,

EER: 7 —2IC [RITHRE] THEEShEBMEREZ—45 v k7 7 JLIC Timestamp with
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